Dear Dr. Brunaud,

The proof of your manuscript is attached on the following pages. Please read through the document carefully to check for accuracy, reference citations, and figures and tables. Please also be aware a professional copyeditor may have edited your manuscript to comply with the GS style requirements.

In addition to proofing the article, the following queries have arisen during the preparation of your paper. Please address the queries listed below by making the appropriate changes in the text.

If you have any other revisions that you would like to make, this will be the last opportunity to do so before the article is published. In particular, please ensure that the author’s names and affiliations have been identified correctly, and the address of the corresponding author is correct.

If the changes cannot be easily described through email, please annotate this proof according to the annotation guidelines as detailed on the following page.

<table>
<thead>
<tr>
<th>Query reference</th>
<th>Query</th>
<th>Author’s response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>Please note that the link with the DOI number for the manuscript should be valid only after the whole issue is official published.</td>
<td></td>
</tr>
<tr>
<td>Q2</td>
<td>Please note that alterations cannot be made after you have approved for publication, irrespective of whether it is Online First.</td>
<td></td>
</tr>
<tr>
<td>Q3</td>
<td>Author SURNAMES (family names) have been highlighted in red - please check that these are correct.</td>
<td></td>
</tr>
<tr>
<td>Q4</td>
<td>Please check affiliations, correspondence details.</td>
<td></td>
</tr>
<tr>
<td>Q5</td>
<td>Please check acknowledgements section and confirm the disclosure.</td>
<td></td>
</tr>
</tbody>
</table>

Once you have completed your revisions and/or addressed all the queries, or if you are satisfied with the proof in its existing form, please email: e-proof@amegroups.com.

To ensure the timely publication of your article, please respond within 48 hours.
Making corrections


Adobe Professional 7:
Tools → Commenting → show Commenting Toolbar

Adobe Reader 8:
Tools → Comments & Markup → show Comments and Markup Toolbar

Adobe Reader 10 and above:
Comment → choose either Sticky Note or Highlight Text

Figure 1 Adobe Acrobat X

<table>
<thead>
<tr>
<th>In-text edits</th>
<th>Select the appropriate symbol and then click and drag over the text to be modified.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace</td>
<td>$\Rightarrow$: denotes where the text should be replaced with an alternative option</td>
</tr>
<tr>
<td>Strikethrough</td>
<td>$\equiv$: crosses out the text</td>
</tr>
<tr>
<td>Underline</td>
<td>$\underline{}$: underlines the text</td>
</tr>
<tr>
<td>Add note to text</td>
<td>$\Rightarrow$: links selected text with a pop-up note</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sticky notes</th>
<th>To make a note: choose the Sticky Note option and then click on a desired location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the name</td>
<td>double-click and choose Options → Sticky Note Properties → General → insert desired name</td>
</tr>
<tr>
<td>To move</td>
<td>click anywhere (apart from the text field) and drag</td>
</tr>
<tr>
<td>To resize</td>
<td>click on the right or left hand order and drag</td>
</tr>
<tr>
<td>To close</td>
<td>click the box on the upper right corner; this does NOT delete your note</td>
</tr>
<tr>
<td>To delete</td>
<td>click and press the Delete keyboard button or right click and select delete from the drop-down menu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Highlighting</th>
<th>This allows you can highlight parts of the text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To highlight</td>
<td>select Highlight and then click and drag over the text to be highlighted. When finished, click on Highlight again to turn off the option.</td>
</tr>
<tr>
<td>To change the colour</td>
<td>double-click on the highlighted text and choose Options → Properties → Appearance → Color</td>
</tr>
</tbody>
</table>

Saving your changes:
Click on File → Save before closing the document.

For more detailed instructions on using Adobe Acrobat, please refer to http://www.adobe.com/support/acrobat/gettingstarted/
Endoscopic and robotic parathyroidectomy in patients with primary hyperparathyroidism

Laurent Brunaud1,2, Zhen Li1,2,3, Klaas Van Den Heede4,5, Thomas Cuny6, Sam Van Slycke4,5

1Department of Digestive, Hepato-Biliary and Endocrine Surgery, Université de Lorraine, CHU Nancy (Hospital Brabois Adultes), 54511 Vandoeuvre les Nancy, France; 2INSERM U954, Université de Lorraine, Faculté de médecine, 54511 Vandoeuvre les Nancy, France; 3Department of General Surgery, Zhongnan Hospital of Wuhan University, Wuhan 430071, China; 4Department of General and Endocrine Surgery, Onze-Lieve-Vrouw Clinic, Aalst, Belgium; 5Department of Head and Neck Surgery, Ghent University Hospital, 9000 Ghent, Belgium; 6Department of Endocrinology, Université de Lorraine, CHU Nancy (Hospital Brabois Adultes), 54511 Vandoeuvre les Nancy, France

Contributions: (I) Conception and design: L Brunaud, S Van Slycke; (II) Administrative support: L Brunaud; (III) Provision of study materials: Z Li, K Van Den Heede, T Cuny; (IV) Collection and assembly of data: Z Li, K Van Den Heede, T Cuny; (V) Data analysis and interpretation: L Brunaud, T Cuny, S Van Slycke; (VI) Manuscript writing: All authors; (VII) Final approval of manuscript: All authors.

Correspondence to: Laurent Brunaud, MD PhD. Department of Digestive, Hepato-Biliary and Endocrine Surgery, CHU Nancy (Hopital Brabois Adultes), Université de Lorraine, 11 allée du morvan, 54511 Vandoeuvre-les-Nancy, France. Email: l.brunaud@chu-nancy.fr.

Abstract: Primary hyperparathyroidism (PHPT) is one of the most common endocrine disorders for which parathyroidectomy is the most effective therapy. Until late 1970s, the standard approach to parathyroidectomy was a four-gland exploration using a large skin incision. However, 80 to 85 percent of cases of PHPT are caused by a single adenoma. As such, the concept of performing a bilateral exploration in order to visualize all four glands has been argued to be excessive since in the majority of cases, there is only one abnormal gland. Focused exploration (one gland) is currently the standard technique for parathyroidectomy worldwide. Despite a rapid acceptance of minimally invasive approaches in most endocrine surgery centers, the use of an endoscope with or without the use of a robotic system to perform parathyroidectomy remains controversial. The goal of this study was to review current available data about surgical approaches using an endoscope with or without the use of a robotic system in the management of patients with PHPT. For conventional endoscopic and video assisted parathyroidectomy, several comparative studies have demonstrated some advantages in terms of reduced postoperative pain, better cosmetic results and higher patient satisfaction compared to open non-endoscopic minimally invasive parathyroidectomy. Robot-assisted transaxillary parathyroidectomy has the advantage of leaving no scar in the neck but its role has not yet been delineated clearly given the limited number of published series. Subjective postoperative cosmetic evaluation is good by concealing the scar in the axilla or infraclavicular area. However, this approach is associated with more extensive dissection than during conventional open or endoscopic neck access surgical procedures. Patients with true ectopic mediastinal parathyroid glands are good candidates for conventional or robot-assisted thoracoscopic approaches because these glands are in remote and narrow anatomical locations.

Keywords: Parathyroidectomy; parathyroid; parathormone; minimally invasive; intraoperative parathyroid hormone (IOPTH); robotics

Submitted Oct 13, 2015. Accepted for publication Dec 29, 2015.

doi: 10.3978/j.issn.2227-684X.2016.01.06

View this article at: http://dx.doi.org/10.3978/j.issn.2227-684X.2016.01.06
Introduction

Primary hyperparathyroidism (PHPT) is one of the most common endocrine disorders for which parathyroidectomy is the most effective therapy. Until late 1970s, the standard approach to parathyroidectomy was a four-gland exploration performed under general anaesthesia using a large skin incision. This operation has a cure rate as high as 97% while maintaining a complication rate of around 1–2% (1). However, 80 to 85 percent of cases of PHPT are caused by a single adenoma. As such, the concept of performing a bilateral exploration in order to visualize all four glands has been argued to be excessive since in the majority of cases, there is only one abnormal gland (2). In the early 1980s, pioneers in the field began evaluating the success of performing parathyroidectomy without assessing all four glands. Unilateral exploration (one side) and then selective or focused parathyroid surgery (one gland) have been proposed since the introduction of improved preoperative localization studies and intraoperative parathyroid hormone (IOPTH) monitoring (3,4). Focused exploration is currently the standard technique for parathyroidectomy worldwide (1,4-6).

With these advances in parathyroid surgery, the size of the cervical incision has become smaller (2,4). Terms such as “minimally-invasive”, “minimal-access” and “mini-incision” have become commonplace in the surgical community when describing parathyroidectomy. However, the general term “minimally invasive parathyroidectomy” is used as a generic term to encompass all of these operative approaches to parathyroidectomy. As such, minimally invasive parathyroidectomy has become difficult to define and there is no current consensus on what defines minimally invasive parathyroidectomy (2). However, most endocrine surgeons agree that an incision of 2.5 cm or less with minimal dissection (adenoma excision and no dissection of the normal glands) fulfils the criteria (3,4,6-9).

Despite a rapid worldwide acceptance of these so-called “minimally invasive approaches” in most endocrine surgery centers, the use of an endoscope with or without the use of a robotic system to perform parathyroidectomy remains controversial (7). The endoscope has the advantage to provide light and magnification but introducing an endoscope in the neck does not mean by itself that you perform a minimally invasive procedure (7,10,11). The concept of surgical invasiveness cannot be limited to the length of the skin incision and should be extended to other structures dissected during the procedure. For example, extra-cervical approaches have the advantage of leaving no scars in the neck but can not be considered as minimally-invasive since more extensive dissection is usually needed than during the conventional open procedure (7,11). The goal of this study was to review current available data about surgical approaches using an endoscope in the management of patients with PHPT. As recently proposed, we classified available surgical approaches as totally endoscopic versus video-assisted, and without versus with the use of a robotic system (2).

Endoscopic parathyroidectomy without robotic system

Minimally invasive selective parathyroid surgery is currently well established and widely performed worldwide (2,10). However, literature review and international surveys have also shown that most common approaches for minimally invasive parathyroidectomy correspond in fact to open focal mini-incision (about 70%), followed by video-assisted approach (about 20%), and totally endoscopic approach (about 10%) (1,3,7,12). Procedures that imply the utilization of the endoscope (totally endoscopic and video-assisted techniques) take advantage not only of the targeted approach, but also of the endoscopic magnification that allows performing the same intervention through a very minimal incision (7,10). Although not supported by evidence based data, it has also been argued that the use of an endoscope was theoretically associated with a lower risk of complications due to optimal visualization of neck structures (recurrent laryngeal nerves and parathyroid glands) (10). We believe as others that totally endoscopic and/or video-assisted procedures are particularly suitable for parathyroid surgery, since they correspond to an ablative procedure for a benign disease in a small working space with important anatomical landmarks to be respected (10). However, we also acknowledge that these techniques are associated with dedicated surgical instrumentation, relatively prolonged learning curve, and usually the need for general anaesthesia (10,11). All those different surgical approaches also need precise preoperative localization imaging studies.

Parathyroidectomy techniques using an endoscope can be classified into totally endoscopic and video-assisted procedures. Total endoscopic parathyroidectomy was first described by Gagner et al. in 1996 (13). Initial technique was carried out entirely under a steady gas flow, using a 5 mm endoscope introduced through a central trocar, and two or three additional trocars for needlescopic instruments. The dissection was first performed beneath the platysma to...
obtain a good working space. The midline was then opened
and the strap muscles were retracted to expose the thyroid
lobe and explore the parathyroid glands after dissecting
the thyroid from the fascia (10). This initial approach
using a central cervical access and gas insufflation has been
subsequently modified over time but is currently rarely
performed (10,14). This evolution is mainly explained by
the fact that this central approach with gas insufflation does
not allow complete and easy exposure to parathyroid glands
localized posteriorly (10,14). Consequently, this surgical
access has been considered to be well adapted for anteriorly
located parathyroid glands and when inferior parathyroid
adenomas are located at the tip of the inferior pole of the
thyroid, or along the thyro-thymic ligament. However,
this anterior access is not always suitable for removal of
parathyroid adenomas deeply and posteriorly located in the
neck because thyroid volume may hamper the dissection.
The lateral access (or back-door access) using the plane
between the strap muscles medially and the carotid sheath
laterally has been considered to be much more suitable for
these posteriorly located parathyroid adenomas (7,11).

Totally endoscopic lateral approach was first described
by Henry et al. in 1999 (15). A 10-mm incision is made
at the anterior border of the sternocleidomastoid muscle
and deepened by sharp and blunt dissection to create a
space lateral to the ipsilateral thyroid lobe and medial
to the carotid artery and the internal jugular vein. Two
3-mm trocars are introduced cranially and caudally to the
incision along the anterior sternocleidomastoid muscle
border and a 5-mm trocar with a 0° endoscope is placed in
the initial incision, which is temporarily closed by a purse-
string suture. Carbon dioxide is insufflated at a pressure
of 8 mmHg to expand the artificial space, and dissection is
performed with 3-mm instruments (Figure 1). During the
procedure, identification of the recurrent laryngeal nerve
and the ipsilateral parathyroid are often easily possible
(3,7,15).

For totally endoscopic lateral approach (Henry
 technique), evaluation has been made by five retrospective
studies and one comparative studies (3,7,11,15). A
prospective study including 200 patients showed that more
than half of all patients (52%) with PHPT could undergo
totally endoscopic lateral parathyroidectomy with a 98%
cure rate. In this series, this approach was associated with
complications rate similar to conventional techniques.
According to Clavien classification, postoperative morbidity
was 6% [two patients were in Clavien 1 (hyperthermia,
malaise), eight patients in Clavien 2 (pulmonary infection,
urinary infection, wound inflammation, conjunctivitis),
and one patient in Clavien 3 (ICU for heart attack)]. There was
no mortality. Transient recurrent laryngeal nerve palsy was
observed in five patients (2.5%) and remained permanent in
one patient (0.5%). Eleven patients (5.5%) had a transient
postoperative hypocalcemia. There were no cases of
permanent hypoparathyroidism (3). However, conversion
rate remained an important issue (28%) and patient
selection, disease severity, and adenoma localization had no
significant impact on conversion rate (3). In this prospective
study, causes for conversion were lack of intraoperative
localization (11%), difficult dissection (10%), bleeding
(4%), failure of normalization of IOPTH results (2%), and
other causes (1%). Gland localization (areas 1 to 2 versus
area 3 in Henry classification) and disease severity score
(CaPTHus score <3 versus ≥3) were not associated with the
risk of conversion (3,16). In another series evaluating
medium-term results, Maweja et al. reported a cure rate
of 98.5% with one case of recurrent disease in 394 totally
endoscopic lateral procedures after a median follow-up
of 20.5 months (17). The main technical limitation of the
technique is considered to be the unilateral approach that
prevents the possibility to accomplish bilateral exploration
(during the same procedure) when necessary. This approach
also emphasizes the need for good preoperative imaging
studies in localizing posterior adenomas (areas 1 and 2) and
their relationship with the recurrent laryngeal nerve (11).
Overall, totally endoscopic lateral approach is not widely
performed, and studies evaluating this technique have
remained unfrequent (3,7,11,15).

Besides those techniques with direct cervical access, other
procedures with an extra-cervical endoscopic approach
have also been proposed (10,11). These approaches gained
initial success mainly in the Asian surgical community, where avoiding any neck scar is culturally important.

Hence, extra-cervical accesses from the chest wall, breast, oral cavity, retro-auricular region (facelift incision) and axilla to perform parathyroidectomy have been reported (18-20). All those endoscopic techniques are characterized by continuous CO₂ insufflation or mechanical external retraction to maintain the operative working space for dissection and trocar positioning (10). All those extra-cervical endoscopic approaches provide optimal cosmetic results in the neck but are technically demanding, are associated with extra-cervical incisions with the need for extended dissection to reach the neck with potential related complications, and are difficult to be reproduced, especially by unskilled endoscopic surgeons (10).

Video-assisted parathyroidectomy was first described by Miccoli et al. in 1997 (21). The procedure is performed partially with the help of the endoscope (video-assisted parathyroidectomy). It is a gasless procedure carried out through a 15–20 mm skin incision made at the suprasternal notch, in the midline. The skin incision is usually higher than in conventional cervicotomy and can also be modulated on the basis of the preoperative imaging findings. The working space is maintained with small conventional retractors. The patient, under general or locoregional anaesthesia with cervical block, is positioned with the neck in slight extension. The surgical team needs to be composed of the main surgeon and two assistants (10). The thyroid lobe is medially retracted while the strap muscles on the affected side are retracted laterally. At this point, the endoscope (5 mm, 30°) and the small surgical instruments are introduced through the single skin incision without using any trocar. After identifying the inferior laryngeal nerve, a targeted exploration is usually carried out to identify the abnormal gland that was localized preoperatively. In case of multiglandular disease or inadequate preoperative localization studies, bilateral parathyroid exploration can be performed by the same video-assisted technique through the same central skin incision (10).

Several large retrospective series have reported perioperative outcomes of video-assisted approach for parathyroidectomy. In 2004, Miccoli et al. reported 350 patients with a postoperative cure rate of 98.3% (22). Persistent disease was observed in 1.1% of patients and was due to false-positive results of intraoperative PTH evaluation that failed in recognizing multiglandular disease. Complications occurred in 14 patients (4%) corresponding to transient hypocalcaemia (2.7%), definitive recurrent nerve palsy (0.8%) and postoperative bleeding (0.3%) (22). Lombardi et al. reported in 107 patients similar success rate (98.1%) and higher rate of temporary postoperative hypocalcaemia (11.1%) likely due to bilateral parathyroid glands dissection or close monitoring of postoperative calcium levels (23). Conversion rates were highly variable among studies and ranged from 0.9% to 43% (10). As all specialized surgical procedures, we believe proper patient selection and surgical team experience have an important impact on conversion rates and this specific criterion should be taken into account when evaluating new surgical techniques (24,25).

Potential advantages of video-assisted over totally endoscopic approach for parathyroidectomy correspond to the possibility to combine conventional open surgery and endoscopic magnification during the same procedure leading to easier learning curve potentially, the possibility to perform bilateral neck exploration when necessary through the same central access, and the allowance for thorough exploration of deeply located inferior pathologic glands (i.e., retrosternal, intrathymic) (10). However, there is some criticism concerning the number of members of the surgical team because two skilled assistants are needed to accomplish the procedure. Also, not all patients are eligible for video assisted procedure, especially in areas of endemic goiter, where a large thyroid gland can hinder video-assisted dissection from central access. Hence, it was reported that only 37% of patients with PHPT were eligible within an endemic goiter area (10). Overall, totally lateral endoscopic and video-assisted parathyroidectomies have never been compared head-to-head but these approaches would likely have similar perioperative outcomes and postoperative cure rates. In both approaches, there is a need for an extensive learning period and the use of specific instrumentation. Similarly, dissection and extraction of large adenomas (≥25–30 mm) through a small incision are potentially difficult during both approaches and can result in capsule rupture with the risk of parathyromatosis (3,10).

Totally endoscopic and video assisted parathyroidectomies have good cosmetic results, and the absence of extensive neck dissections may result in low postoperative pain. For both approaches, several comparative studies have demonstrated some advantages in terms of reduced postoperative pain, better cosmetic results and higher patient satisfaction compared to conventional and open non-endoscopic minimally invasive parathyroidectomy (1,5,8,10). We believe that this recent comparative study evaluating video assisted versus open minimally invasive parathyroidectomy...
provides relevant data regarding this issue (26). Of 455 patients with PHPT and a solitary parathyroid adenoma on preoperative imaging, 151 underwent video assisted (33%) and 304 had open minimally invasive parathyroidectomy (67%). The following outcomes were favorable for video assisted parathyroidectomy: lower pain intensity during 24 h postoperatively (P<0.001), lower analgesics request rate (P<0.001), lower analgesics consumption (P<0.001), higher recurrent laryngeal nerve identification rate (P<0.001), shorter scar length (P<0.001), and better cosmetic satisfaction at 6 months (P=0.024) after surgery. However, video assisted parathyroidectomy had longer duration of surgery (P<0.001), and was more expensive (P<0.001). No differences were noted in the conversion rate, length of hospital stay, and morbidity (26).

Endoscopic parathyroidectomy with robotic system

The inherent limitations of cervical and extracervical endoscopic surgical approaches have lead to the emergence of robotic parathyroidectomy as an alternative option (27). The causes of this limitation are mainly related to the technical difficulties encountered with conventional endoscopic surgery, for which the surgeon uses instruments without articulated ends, which thus provide only four degrees of freedom. Such instruments modify the performance of the surgical procedure as compared to open surgery, where surgeons can position their bodies and use their shoulders, elbows, wrists, and finger joints for optimal control of the surgical movements. In addition, the physician views endoscopic surgery on a 2-dimensional screen, which has no depth of field. The camera is not manipulated by the surgeon but by an assistant, which can also affect the quality of the field of vision. Finally, alignment of the visual field with the ends of the instruments is rarely achieved; this problem creates a significant fatigue factor that interferes with the precision of the surgeon’s hand movements (28).

In this context, the development of robotic surgery is part of a process intended to give patients the advantages of endoscopic surgery while endeavouring to overcome the aforesaid difficulties routinely encountered by endoscopic surgeons.

Robotic surgery consists of “simply” placing a computer interface between patient and surgeon to optimize the feasibility and quality of the surgical procedure. It is not a new approach but a logical evolution from conventional endoscopic surgery. Almost all medical specialties (radiologists, cardiologists, radiation oncologists, etc.) have used computers for years in order to improve patients’ care. Why should surgeons be the last medical specialists to use it? With the 3-dimensional display, robotic systems enable the surgeon to work in a comfortable position: eye, hand and target are in line and the instruments contain a “wrist” joint to improve dexterity. Although not validated by current evidence-based data, it has been hypothesized that these advantages could theoretically improve peri- and post-operative outcomes for patients as well as ergonomy and surgical procedures feasibility for surgeons. Reported experience with robotic parathyroidectomy is currently limited and corresponds mainly to extracervical approaches (29).

In 2011, Tolley et al. prospectively evaluated 11 selected patients with PHPT (30). Patients with significant thyroiditis, large thyroid volume, and previous neck surgery were excluded. An ipsilateral infraclavicular incision and three small incisions in the ipsilateral anterior axillary line were performed. The parathyroid adenoma was successfully excised in all 11 patients and there were no complications. The recurrent laryngeal nerve was identified in all cases. Mean operative time was 61 min. One patient had persistent disease and one patient required conversion to open surgery due to high body mass index (30,31). The same year, Landry et al. reported two patients who underwent transaxillary robotic parathyroidectomy (32). In this study, both patients had their adenoma localised pre-operatively. Despite the long operative times (115 and 102 min respectively) there were no complications with the parathyroid adenoma successfully excised in both cases.

In 2012, Foley et al. compared four transaxillary robotic parathyroidectomy patients against 12 matched controls that underwent targeted open parathyroidectomy (33). All robotic parathyroidectomy patients were cured, but the mean operative time in this group of patients was significantly longer. This study concluded that improved cosmesis should be weighed against the length of surgery and increased cost associated with robotic parathyroidectomy. Nourelidine et al. retrospectively evaluated nine patients who underwent transaxillary robotic parathyroidectomy by a single surgeon (34). All patients were cured and one patient required conversion to cervicotomy with four-gland exploration when intraoperative PTH monitoring suggested the presence of multiglandular disease. No complications were reported (with routine pre- and postoperative laryngoscopy). At 6-month follow-up, the overall cosmetic outcome was subjectively considered to be good with the incision scar located in...
the axilla area. Lastly, Karagkounis et al. retrospectively evaluated eight patients who underwent transaxillary robotic parathyroidectomy for a preoperatively localized cervical parathyroid adenoma (35). All patients were cured of their disease with 6-month follow-up. The only complication was seroma formation in one patient (13%) and there was no need for conversion to open surgery.

To date, no robotic procedure to perform parathyroidectomy for PHPT and using neck incisions has been published. This is likely due to the fact that the robotic system is generally used to avoid neck scars as proposed by Asian groups for robotic thyroidectomy. However, Van Slycke et al. showed that the use of a robotic system to perform a lateral endoscopic cervical parathyroidectomy as described by Henry et al. was feasible (15). An 8.5 mm incision is made laterally in the neck on the anterior side of the sternocleidomastoid muscle. Through this incision, a dissection is performed, providing an access medially of the carotid artery and laterally of the strap muscles. Through two extra 5 mm incisions, two working trocars were placed 3 to 4 cm cranially and caudally from the central incision. Consequently, the optical trocar is placed and fixedated with a seam around the central incision. To obtain good visibility during the whole procedure, CO₂ is insufflated up to a constant pressure of 8 mmHg. The robotic instruments are consequently docked under endoscopic control with a grasper placed in the left robotic arm and a monopolar cautery hook placed in the right arm (Figure 2).

Robotic assisted parathyroidectomy through a lateral cervical approach has shown to be a safe and feasible procedure especially in patients with a posteriorly localized parathyroid adenoma (areas 1 to 2 versus area 3 in Henry classification) (3,11). When compared to the conventional endoscopic technique, we believe that the use of the Da Vinci Surgical System adds several benefits to the neck dissection. The ability to generate a high definition 3-dimensional visual environment combined with a stable camera platform enhances the visibility of the recurrent laryngeal nerve, and parathyroid glands. Another advantage is the articulation of the instruments, which makes it possible to better manipulate the parathyroid gland compared to the endoscopic conventional instruments. However, we acknowledge that these potential advantages should be confirmed by evidence-based data.

To summarize, current available literature have shown that robotic parathyroidectomy was feasible and safe. As in other focused open or endoscopic approaches for parathyroidectomy, robotic parathyroidectomy is currently performed in selected patients with preoperatively localized parathyroid adenoma. Subjective postoperative cosmetic evaluation is good by concealing the scar in the axilla or infraclavicular area. No cosmetic data is currently available for robotic parathyroidectomy using neck incisions. Preliminary results for robotic parathyroidectomy have shown to be equivalent to conventional open parathyroidectomy with regards to cure in this selected group of patients.

At present, there are still some disadvantages associated with the robotic approach. There is a higher mean cost. In some institutions, this extra cost is discussed preoperatively and covered by patients. Interestingly, trade-offs are not similar between patients and surgeons. For example, a substantial number of US citizen (about 20%) would accept a higher rate of perioperative complications (×10 times higher rate) in order to undergo a transaxillary approach without postoperative neck scar (36). It is not sure that endocrine surgeons would agree on same conclusions! However, it is also likely that some patients would agree to pay out of pocket to get no neck scar after robotic parathyroidectomy. Second, a longer mean operating time in robotic group patients have been observed. We believe that this is due to initial learning curve and increased experience will lead to equivalent or even shorter mean operative time, as observed in other surgical fields (37).

Ectopic localizations

Mediastinal parathyroid glands can reach 20% incidence in the case of PHPT and in most cases these intrathymic parathyroid glands can be removed through a cervical incision. Nevertheless, in about 2% of cases, a thoracic approach is necessary to resect true ectopic parathyroid
glands responsible for PHPT. Recent advances in thoracoscopic surgery have allowed for a minimally invasive management using conventional thoracoscopic approach (1,38). The rarity of deep mediastinal parathyroids explains the low number of cases treated by thoracoscopy reported by the literature. A large retrospective study including 13 patients who underwent thoracoscopic removal of mediastinal parathyroids showed that thoracoscopy enabled retrieval of mediastinal parathyroids in 10 of 13 (78%) cases (38). Mean operating time was 92 min. One procedure (8%) was converted. No perioperative deaths or major complications occurred. Mild complications occurred in 2 of 13 (15%) patients (pneumothorax, pneumonia, transient recurrent nerve palsy). Mean hospital stay was 4.7 days (38). This study concluded that the thoracoscopic approach for mediastinal parathyroidectomy was feasible and safe. An accurate preoperative work-up was mandatory to avoid unsuccessful procedures (1,38).

The feasibility and effectiveness of robot-assisted dissection for mediastinal ectopic parathyroid glands have also been reported (39). However, only a limited number of case series is available in the current literature. In one of the largest study, parathyroidectomy for mediastinal ectopic glands was performed thoracoscopically in 5 patients (3 primary and 2 secondary hyperparathyroidism) with the robotic system using a three-trocar approach (39). All procedures were completed successfully with the robotic system. No perioperative morbidity or mortality was noted. Median operating time was 58 min. Intraoperative PTH reduction indicated complete resection. Median hospital stay was 3 days (39). This study concluded that robot-assisted dissection was a promising approach for resection of ectopic parathyroid glands in remote narrow anatomical locations such as the mediastinum (Figure 3).

**Conclusions**

The use of an endoscope to perform parathyroidectomy for PHPT has the potential advantage to provide light and magnification. However, its role in clinical practice with or without robotic system is still a matter of debate. For conventional endoscopic and video assisted parathyroidectomy, several comparative studies have demonstrated some advantages in terms of reduced postoperative pain, better cosmetic results and higher patient satisfaction compared to open non-endoscopic minimally
invasive parathyroidectomy. Robot-assisted transaxillary parathyroidectomy has the advantage of leaving no scars in the neck but its role has not yet been delineated clearly given the limited number of published series. Subjective postoperative cosmetic evaluation is good by concealing the scar in the axilla or infraclavicular area. Nevertheless, we believe that mean age observed in parathyroidectomized patients emphasizes that postoperative cosmetic issue is likely not the principal postoperative claim in this group of patients. Patients with true ectopic mediastinal parathyroid glands are good candidates for conventional or robot-assisted thoracoscopic approaches because these glands are in remote and narrow anatomical locations.

Acknowledgements

None.

Footnote

Conflicts of Interest: The authors have no conflicts of interest to declare.

References


